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<Warning> Spoilers are in this guide!!! 
Rated T for Teen by ESRB 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
Introduction: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
 Hi. This is a Guide for DBZ: Taiketsu as you can see.  
It is also my first FAQ.  The intro is for telling  
you a bit about the game.  This game is made by Atari and  
Webfoot.  Of the long line of DB/Z/GT games, this is probably  
the easiest.But it’s one of the most rewarding to.  It has  
good 3-D clay-like graphics, average sound quality, and a  
good replay value! Since it is the first DBZ fighting game for 
the GBA, you should go easy on it.  Webfoot just needs some  
practice, a LOT of practice. 
 Actually, the graphics are somewhere in between 2-D  
and 3-D.  More like, 2.5-D, I would say.  They should  
have stuck with sprites but this is OK by itself! 
 This is the first DBZ fighting game with Broly in  
it (that I know of). 
 So lets read my first FAQ, see how  
I did, and take everything this game has and put it right  
in your hands!¡ 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
Table of Contents: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
A.      Main Menu 
B. How to get the characters 
C. Tournament 
D. Time Challenge 
E. Sparring 
F. Endurance 
G. Multi Player 
H.      Options 
I.      Z STORE 
J.      Basic Moves 
K.      Characters' Specials 
L.      Contacts and Stuff………… 
M.      Special Thanks  
N.      Version History 
O.      Maybes 

Hopefully this guide will help you with what you need. So  
scroll down and find what you need in my first FAQ! 



=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
A. Main Menu 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

After you press start, it brings up the main menu, which looks 
like this:
 One Player -> Tournament -> Choose File -> Choose Character 
               Endurance -> Choose Character 
               Time Challenge -> Choose Character 
               Sparring -> Choose Character 
               Endurance2x* -> Choose Character 
 Multi Player -> (See Multi Player section) 
 Options -> (See Options Section) 
 Z-Store -> (See Z STORE section)  
                
*Have to buy this in the Z-Store 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
B. How to get the characters: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

You start out with: Goku, Vegeta, Gohan, Piccolo, Krillin,  
Android 18, and Trunks. 

Raditz - Beat Tournament with Trunks! 

Nappa - Beat Tournament with Vegeta! 

Gotenks - Beat Tournament with 4 people plus Goku! 

Frieza - Beat Tournament with everyone so far! 

Android 16 - Beat Tournament with all characters so far plus  
two characters in Time Challenge! 

Cell - Beat Tournament Android 16! 

Buu – Beat Tournament characters so far then Time Challenge  
with Piccolo! 

Broly – Beat Tournament or Time Challenge with Buu! 

Note: (You may find other ways to get the characters but this  
is how I got them.) 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
C. Tournament: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
The Tournament mode is the main way to get the characters, with  
your chosen character, you battle your way through 8  
opponents, each one supposedly stronger than the last.  At the 
end of each tournament battle, you see a screen which  
totals up your Z Points, and you see a neat picture from the  
series  
next to it. Once you clear all 8 battles, it will  
tell you what you got for it, (ex: 25,000 extra Z Points, Cell,  
etc.)  
Then it will tell you a battle story… 



Goku: GOKU DEFEATED THE MOST EVIL VILLAINS IN THE UNIVERSE.  HE  
HAD FACED UNIMAGINABLE TERRORS,  
AND BEATEN INCONCEIVABLE ODDS.  HE HAD PROVED HIMSELF AS ONE OF  
THE UNIVERSE’S GREATEST HEROES.  HOWEVER,  
NOTHING COULD HAVE PREPARED HIM FOR HIS ULTIMATE CHALLENGE: THE  
WRATH OF HIS WIFE CHI-CHI! 

Gohan: UNLEASHING THE RAGE HIDDEN DEEP WITHIN, GOHAN WAS ABLE  
TO DEFEAT THE EVILS THAT ONCE THREATNED THE PLANET.  
WITH THE WORLD SAFE FROM DANGER, GOHAN RETURNED TO HIS EVERY  
DAY LIFE OF GOING TO SCHOOL, AND BEING A SUPER HERO. 

Piccolo: HIS HEART ONCE FILLED WITH EVIL, PICCOLO HAD LEARNED  
TO CALM THE WICKEDNESS THAT ONCE FILLED HIS ENTIRE BEING.  
HE SMILED TO HIMSELF AS HE THOUGHT OF THE IRONY, THAT HE HAD  
JUST SAVED THE PLANET HE ONCE LONGED TO CONQUER AND PILLAGE.   
NOW HIS ONLY DESIRE WAS TO PROTECT THE PLACE HE NOW CALLED  
HOME.

Krillin: KRILLIN STOOD STARING INTO THE DISTANCE, IN AWE OF  
HIMSELF.  SOMEHOW HE HAD SUMMONED UP THE COURAGE  
TO SAVE THE WORLD.  HE WONDERED WHERE HE GOT THE CONFIDENCE,  
AND THOUGHT THAT PERHAPS IT WAS HIS LOVE FOR ANDROID 18.   
HAVING JUST WON THE GREATEST BATTLE OF HIS LIFE, HE BEGAN  
TO FLYHOME, DECIDING TO  
TAKE A LONG BREAK FROM FIGHTING. 

Android 18: DURING HER FIGHTS, SOME THING HAD AWAKENED IN  
ANDROID 18. IT WAS THAT URGE FOR DESTRUCTION AND MAYHEM.   
IT WAS HER OLD PROGRAMING THAT DR. GERO HAD INTERGRATED  
INTO HER MIND, REVIVED BY HER AGGRESSIVE FEELINGS.  HOWEVER, 
 HOUGHTS OF HER NEW FRIENDS, ESPECIALLY OF KRILLIN, CALMED  
HERMIND AS SHE LEFT THE BATTLEFIELD. 
   
Trunks: FINALLY IT WAS OVER. THE THREAT TO THE EARTH HAD ENDED.   
TRUNKS CAME FROM THE FUTURE, TO SAVE THE PAST.   
HE CAME FROM A WORLD WHERE SO MANY PEOPLE HE HELD DEAR HAD DIED  
FIGHTING THE ANDROIDS. HE LIVED IN A WORLD OF TERROR,  
AND PROMISED HIMSELF HE WOULD NOT LET IT HAPPEN AGAIN.   
MAYBE NOW HE COULD LIVE IN PEACE. 

Vegeta: VEGETA LOOKED AT THE DESTRUCTION ALL AROUND HIM, A  
RESULT OF THE EPIC BATTLE. WHO WOULD HAVE THOUGHT THAT HE,  
A SAIYAN WARRIOR PRINCE, WOULD HAVE FOUGHT SO STRONGLY TO SAVE  
A TINY INSIGNIFICANT PLANET LIKE EARTH?  BUT SOMEHOW,  
HE HAD COME TO LOVE THIS LITTLE BLUE MARBLE.  “I MUST BE  
HANGING AROUND KAKAROT TOO MUCH,” HE MUTTERED TO HIMSELF. 

Raditz: RADITZ HAD HIS REVENGE AGAINST THE FOOLS WHO KILLED  
HIM!  NOTHING COULD STOP HIM!  HE WAS INVINCIBLE! SUDDENLY 
HE FOUND HIMSELF LYING ON THE GROUND.  HE WAS BACK IN HFIL! 
“HOW CAN THIS BE?!”   
HE SCREAMED.  “I’M INVINCIBLE!”  “INVINCIBLE?”  LAUGHED 
NAPPA.  “YOU BARELY LASTED 5 MINUTES OUT THERE.  YOU’VE  
BEEN KNOCKED OUT FOR THE LAST TWO HOURS!” 

Nappa: NAPPA GRIMLY WONDERED, WHAT WAS NEXT?  HE HAD  
ESCAPED FROM THE HOME FOR INFINITE LOSERS,  
AND EXACTED HIS REVENGE UPON PRINCE VEGETA, AND  
HIS PUNY FRIENDS.  WHAT WAS THERE LEFT TO DO?  THE  



INSTINCTS DEEP WITHIN HIS SAIYAN BLOOD GAVE HIM THE 
AWNSER.  AND SO HE LOOTED AND PILLAGED 
THE GALAXY FOR THE REST OF HIS DAYS. 

Frieza: FRIEZA HAD ELIMINATED ALL HIS ENEMIES. THE  
PROTECTORS OF THE EARTH  
WERE GONE! NOTHING COULD STOP HIM NOW.   
THE DRAGON BALLS WOULD BE HIS, AND ONCE HE GAINED  
IMMORTALITY, THE UNIVERSE  
WOULD TREMBLE!  “I WILL SHOW NO MERCY!”,  
HE SCREAMED, AS HE LAID WASTE TO A CITY LAUGHING  
MANIACALLY. 

Android 16: ANDROID 16’s SERVOS WERE STRAINED.   
EVERY TRANSISTOR IN HIS BODY 
WAS REGESTERING PAIN.   
BUT IT DIDN’T MATTER TO HIM.  HE HAD PROTECTED EARTH.   
HIS SACRIFICE MEANT  
THAT EVERY BIRD, EVERY SQUIRREL,  
EVERY TREE ON THE PLANET WOULD SURVIVE.  HE STARED AT  
THE CLEAR BLUE SKY AND  
SMILED, AS ONE BY ONE HIS SYTEMS  
SHUT DOWN AND THE SHIMMER IN HIS EYES GREW DIM. 

Cell: PERFECTION. CELL HAD FINNALY ACHIEVED DR. GERO’S  
DARK DREAM OF REVENGE.   
HIS MASTER WOULD BE PROUD,  
WERE HE STILL ALIVE!  HE WONDERED WHAT HE WOULD DO NEXT. 
THE EARTH WAS NO LONGER  
A CHALLENGE.  HE THEN REALIZED DR. GERO’S TRUE PURPOSE  
FOR CREATING HIM: THE  
DESTRUCTION OF THE UNIVERSE! 

Gotenks: GOTENKS WAS COMEPLETELY DISAPPOINTED.  HE  
TOTALLY KICKED ALL THE BAD GUYS’ 
 BUTTS!  THE PROBLEM  
WAS THAT NO ONE WAS AROUND TO SEE IT HAPPEN!  THEY  
MISSED ALL HIS AWESOME ATTACKS  
AND RADICAL MOVES!   
IF HE TOLD ANYONE WHAT HAPPENED, WOULD THEY BELIEVE  
HIM?  HE WONDERED IF MAYBE HE  
SHOULD HAVE WAITED FOR A CROWD TO GATHER. 

Buu: BUU’S SIMPLE MIND WAS FILLED WITH JOY AS HE  
DESTROYED THE PLANET EARTH.  HE  
GIGGLED WITH MADNESS.   
HOWEVER, SUDDENLY A TINGE OF REGRET APPEARED IN  
HIS MIND.  HE WOULD MISS ALL THE  
DELICIOUS PASTERIES,  
CHOCOLATES, CANDIES, AND CAKES HE HAD TASTED.   
WHAT WOULD HE DO NOW?  THEN HE  
REMEMBERED THE UNIVERSE IS FULL OF SWEETS! 

Broly: PATHETIC.  THAT WAS THE ONLY WORD BROLY 
COULD THINK OF TO DESCRIBE THE  
SAIYANS HE JUST DEFEATED.   
HE FELT ASHAMED TO SHARE THE SAME RACE.  THEY  
COULD NOT EVEN BEGIN TO  
COMPREHEND HIS LEGENDARY POWERS.   



WAS THERE NO ONE IN THE COSMOS WHO COULD  
CHALLENGE HIM?  HE PONDERED AS HE  
DESTROYED YET ANOTHER PLANET WITHOUT MERCY. 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
D. Time Challenge: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
                                 

 Time challenge is basically the same thing as tournament,  
except you try and get the best time, (as in beating it the  
quickest.)  The battle stories at the end are the same as  
Tournament. 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
E. Sparring: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
       This is where you practice your moves, skills, and  
supers.  There are two modes of it, CPU off, and  
CPU on. This is where I try and figure out specials for new  
characters.  

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
F. Endurance: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

This mode is pretty much self-explanatory.  You see how long  
you can last in a non-stop fight! 
Every time you get a character down to no HP, he/she reverts  
into another character. 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
G. Multi-player: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

This is where you can link up with a friend and duke it off!   
<Note: 2 gamepacks and a link are required to do this mode.> 
Here is the menu layout: 

Battle -> Select Character 
Sparring -> Select Character 

Battle: Duke it out with a friend to see who is the ultimate Z Fighter! 

Sparring: Practice with a friend with infinite HP. 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
H. Options: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

There are a couple options in this game, they are as follows. 
 1) Sound On/Off (Turns sound effects on or off) 
  
 2) Music On/Off (Turns BG music on or off) 
  
 3) Settings > a) Difficulty – easy/med/hard 
              b) Time – 99/60/30 seconds 
              c) Health - 100/50 
              d) Rounds – 1/3/5/7 
              e) Default 



  
 4) Records > a) Endurance 
              b) Time Challenge 
              c) Endurance 2x (more on this later) 
 5) Erase Data > Erase All Saved Data? Yes/No (Erase all  
records, characters, etc.) 

 6) Credits (View people who made this game) 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
I. Z store: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

       This is where you buy all the goodies and stuff with the 
Z points you get in tournament mode. 

Buy > Buy the stuff. 

Image Gallery > View the images bought in buy mode. 
Image 1) SS Vegeta smirking 
Image 2) Androids 18 and 16 
Image 3) SS2 Goku powering up madly 
Image 4) #18 kissing Krillin 
Image 5) Saiyaman kicking Videl 
Image 6) Nappa pic 
Image 7) Freiza and Ginyu force pic 
Image 8) SS Trunks holding a GIANT ki ball 
Image 9) Piccolo throwing out his cape 
Image 10) Raditz pic 
Image 11) Vegeta blocking a punch from #18 
Image 12) Super Buu pic  
Image 13) Vegeta powering up 
Image 14) Buu scaring the life outta Babidi 
Image 15) Cell pic 
Image 16) Perfect Cell powering up 
Image 17) SS3 Gotenks powering up 
Image 18) SS Trunks ready to swipe sword 
Image 19) LSS Brolly pic 
Image 20) Hercule punching #18 in the face! 

Jukebox > Listen to the songs bought in buy mode. 
Song 1) Theme 
Song 2) Conclusion 
Song 3) Namek 
Song 4) Kami’s Lookout 
Song 5) Inside Buu 
Song 6) Go Go Goku  
Song 7) Wasteland 
Song 8) Orange City 
Song 9) Snake Way 

Bios > Look at the bio of each character. (Bought in buy mode) 

Goku: BORN A SAIYAN NAMED KAKAROT, HE WAS ORIGINALLY SENT TO  
DESTROY IT. AS A CHILD, HE HAD AN ACCIDENT, AND FORGOT ABOUT HIS EVIL MISSION, 
AND THUS THE GOOD-NATURED, HONEST, AND CARING GOKU WAS BORN. HE TRAINED 
WITH MASTER ROSHI AND KING KAI TO LEARN SKILLS TO HELP SAVE THE EARTH, AND WAS 
THE FIRST SAIYAN IN A THOUSAND YEARS TO LEARN THE ABILITY TO GO SUPER-SAIYAN. 
GOKU IS THE CENTRAL CHARACTER IN DRAGON BALL Z. HE IS A LONG TIME FRIEND OF 



KRILLEN, HUSBAND OF CHI-CHI, FATHER OF GOHAN AND GOTEN, BROTHER OF RADITZ, 
AND OF THE SAME SAIYAN RACE AS VEGETA, TRUNKS, AND BROLY. HIS SPECIAL ABILITIES 
INCLUDE THE KAMEHAMEHA WAVE AND THE SPIRIT BOMB. 

Gohan: AFFECTIONATLLY NAMED AFTER HIS ADOPTIVE GRANDFATHER, GOHAN IS GOKU & 
CHI-CHI'S ELDEST SON.  AS A YOUNG BOY, GOHAN CRIED A LOT, AND WAS EASILY  
FRIGHTENED; FEW WOULD HAVE GUESSED HE WOULD GROW UP TO BE SUCH A STRONG  
FIGHTER. AFTER HIS FATHER DIED FIGHTING RADITZ, GOHAN TRAINED HARD FOR 
A FULL YEAR UNDER THE SUPERVISION OF PICCOLO. BECUASE GOHAN IS HALF-HUMAN, 
AND HALF-SAIYAN, HIS STRENGTH CAN ACTUALLY EXCEED GOKU'S. HOWEVER CHI-CHI 
OFTEN INSISTS THAT HE CONCENTRATE ON SCHOLASTIC MATTERS RATHER THAN 
FIGHTING. GOHAN HAS THE ABILITY TO BEOCME A SUPER-SAIYAN, AND HIS  
SPECIAL ABILITIES INCLUDE THE KAMEHAMEHA WAVE, AND THE MASENKO-HA. 

Piccolo: PICCOLO ORIGINATES FROM THE PLANET NAMEK. HE WAS BORN AS AN EGG FROM 
THE MOUTH OF THE EVIL PICCOLO DAIMAOU. ORIGINALLY, EVIL PICCOLO INTENDED TO 
DESTROY GOKU. IT WASN'T UNTIL THE FIGHT WITH RADITZ; WHERE GOKU GAVE HIS OWN 
LIFE FOR THE SAKE OF EARTH; THAT PICCOLO REALIZED GOKU HAD A PURE SPIRIT AND 
WAS A CARING PERSON. HE HELPED TRAIN GOHAN TO BE A COURAGEOUS FIGHTER, AND 
IN THE PROCESS MADE A GOOD FRIEND. HE HAS AN AWKWARD LIFE, LIVING ON A PLANET 
THAT ISN'T HIS OWN, AND MAKING THE CONSCIOUS DECISION TO FIGHT FOR GOOD  
INSTEAD OF EVIL. HIS SPECIAL ABILITIES INCLUDE BEING ABLE TO DUPLICATE 
HIMSELF, AND HIS SIGNATURE, THE SPECIAL BEAM CANNON. 

Krillin: DESPITE HIS SIDE, KRILLIN IS ONE OF THE STRONGEST MEN ON EARTH! 
HOWEVER, BECAUSE HE IS AN EARTHLING, THERE ARE TIMES WHEN HE CAN'T 
KEEP UP WITH THE SAIYANS AND THEIR MASSIVE POWER LEVELS. NONETHELESS, 
KRILLIN IS A VERY GOOD FIGHTER, AND HE AND GOKU HAVE FOUGHT ALONGSIDE 
ONE ANOTHER SINCE CHILD-HOOD, WHEN THEY TRAINED TOGETHER UNDER MASTER 
ROSHI. SOME OF HIS ABILITIES INCLUDE THE SUPER HEAD-BUTT, AND DESTRUCTO 
DISC.

Android 18: ANDROID 18 IS ONE OF THE MOST DANGEROUS CREATURES TO EVER 
THREATEN THE EARTH. SHE AND HER TWIN BROTHER, ANDROID 17, WERE THE 
BRAIN-CHILD OF DR. GERO. THE ANDROIDS WERE ORIGINALLY PROGRAMMED TO DESTROY 
GOKU, BUT IN THE SPIRIT OF TEENAGE REBELLION, THEY DISOBEYED THEIR CREATOR, 
DESTROYED HIM AND WREAKED HAVOC AROUND THE WORLD IN A CAREFREE MANNER. 
WHILE SHE MAY LOOK DELICATE AND GRACEFUL, ANDROID 18 CAN BE VIRTUALLY  
EMOTIONLESS, AND SHE IS VERY, VERY POWERFUL. SHE HAS THE ABILITY TO SHOOT 
A SOLID ENERGY BEAM, AND TO SELF-DESTRUCT. 

Trunks: TRUNKS IS THE SON OF VEGETA AND BULMA. AS A RESULT, HE IS A 
GREAT WARRIOR, AND ALSO HAS KEEN TECHNICAL ABILITIES. IN ORDER TO SAVE 
THE WORLD, HE TRAVELED BACK IN TIME TO ORGANIZE THE Z FIGHTERS, IN A RACE 
TO DESTROY DR. GERO'S ANDROIDS BEFORE THEY DESTROYED THE PLANET. BECAUSE 
HE IS HALF-SAIYAN, HE HAS THE ABILITY TO GO SUPER-SAIYAN. TRUNKS WIELDS 
A SWORD, AND USES IT IN HIS MOST POWERFUL ATTACKS, SUCH AS THE TRIPLE  
SLASH, AND THE FINAL SLASH. 

Vegeta: VEGETA WAS FORMERLY A PRINCE OF THE PLANET VEGETA. HE CAME TO  
EARTH WITH NAPPA WITH THE INTENTION OF CAPTURING THE DRAGONBALLS,  
BUT EVENTUALLY MADE IT HIS HOME. HE HAS ALWAYS BEEN JEALOUS OF THE FACT 
THAT GOKU IS MERELY A DESCENDANT OF THE PEASANT CLASS, YET ALWAYS SEEMS 
TO BE MORE POWERFUL. VEGETA IS AN EXCELLANT FIGHTER THOUGH, AND THROUGH 
ENDLESS SELF-DETERMINATION, HE HAS TRAINED HIMSELF TO GO SUPER-SAIYAN, 
AND RAISED HIS POWER LEVEL TO UNBELIEVABLE ACCOLADES. AS HE GREW OLDER 
AND ADJUSTED TO THE GOOD NATURE OF THE Z FIGHTERS, HE SOFTENED UP A BIT, 
AND HAD A CHILD WITH BULMA, NAMED TRUNKS. VEGETA'S SPECIAL ABILITIES 
ARE THE GALICK GUN, BIG BANG, AND THE ABILITY TO TURN INTO A GIANT 
OOZARU MONKEY. 



Frieza: THE MERE MENTION OF THE NAME 'FREIZA' STRIKES DREAD IN THE HEARTS 
OF MANY ACROSS THE UNIVERSE. IN HIS QUEST TO AQUIRE ALL 7 OF THE DRAGON 
BALLS, HE DESTROYED THE PLANET NAMEK. THE ONLY PERSON CAPABLE DEFEATING 
HIM WAS GOKU, WHO DID NOT QUITE FINISH HIM OFF, AND FRIEZA WAS REBUILT 
BY KING COLD, HIS RUTHLESS FATHER. WITH A NEW CYBERNETIC BODY, FRIEZA 
WENT TO EARTH TO GET REVENGE. HOWEVER, HIS ATTEMPT WAS THWARTED BY  
TRUNKS. FRIEZA HAS THE ABILITY TO SHOOT SHOOT FROM HIS EYES, AND 
TO CREATE A DEATH BALL, WHICH UNLEASHES A POWERFUL BLAST UPON THE 
EARTH, IF IT IS ALLOWED TO DETONATE.  

Android 16: ANDROID 16 WAS AN EXPIRIMENT OF DR. GERO'S THAT WAS NEVER SUPPOSED  
TO BE SET FREE. DISOBEYING DR. GERO'S ORDERS, ANDROID 17 AND 18 DID JUST THAT. 
HIS PROGRAMMING WAS NEVER COMPLETE, SO HE WAS VERY SINGLE MINDED: DETERMINED  
TO DESTROY GOKU WHILE NEVER HARMING ANYTHING ELSE. AFTER ALMOST BEING  
DEMOLISHED BY CELL, BULMA RE-PROGRAMMED HIM TO FIGHT FOR THE GOOD SIDE. THE 
STRONG, SILENT TYPE, HE IS MASSIVE AND MUSCULAR, BUT CAN BE VERY GENTLE  
OUTSIDE OF A FIGHT. HE HAS THE ABILITIES OF ROCKET PUNCH, AND SELF-DESTRUCT, 
TO NAME A FEW. 

Cell: CELL WAS THE LAST, AND MOST DANGEROUS, OF DR. GERO'S CREATIONS. HIS NAME 
REFERS TO THE FACT THAT HE IS COMPOSED OF THE CELLS OF THE BEST FIGHTERS IN  
THE WORLD, INCLUDING THOSE OF THE Z FIGHTERS. HIS QUEST IS TO ABSORB ANDROID 
17 AND 18 AND BECOME A PERFECT BEING. CELL CAN FIGHT WITH ABILITIES OF ALL THE 
FIGHTERS HE HAS ABSORBED, AND SOME OF HIS MOVES INCLUDE THE KAMEHAMEHA WAVE  
AND TAIL STAB. 

Gotenks: THE METAMORU ART OF FUSION ALLOWS THE TWO FRIENDS, GOTEN AND TRUNKS, 
TO JOIN TOGETHER TO BECOME A SINGLE VERY POWERFUL BEING. LIKE THE BOYS 
THEMSELVES, GOTENKS HAS THE ABILITY TO LEARN NEW MOVES QUICKLY, AS WELL AS 
GO SS3. DESPITE HIS SIZE GOTENKS IS AN EXELLENT FIGHTER, AND HIS MOVES 
INCLUDE THE KAMEHAMEHA WAVE, SUPER GHOST KAMIKAZE, AND GEKITOTSU ULTRA 
BUU BUU VOLLEYBALL. 

Buu: BUU WAS CREATED 300 YEARS AGO BY AN EVIL WIZARD NAMED BIBIDI. HE WAS  
RECKLESS IN HIS DESTRUCTION OF PLANETS, SO HE WAS UNLEASHED TO DESTROY EARTH 
BY BIBIDI'S SON, BABIDI. THANKFULLY, BUU WAS CONVINCED BY HERCULE NOT TO HURT 
PEOPLE ANYMORE--BUT HE'S NOT TOO BRIGHT, HE DEFINATELY HAS AN ANGRY SIDE. 
BUU'S LARGE, RUBBERY BODY AFFORDS HIM AN UNIQUE EDGE IN THE MATCH, AND HE CAN 
BE A TOUGH FIGHTER. HIS SPECIAL ABILITIES INCLUDE MOLDING HIMSELF INTO A FIST, 
AND THE HENKA BEAM, WHICH CAN HELP CURB BUU'S APPETITE BY CREATING FOOD.  

Broly: BROLY IS AN EXCEPTIONAL SAIYAN; HE WAS BORN SUPER SAIYAN! BORN AT THE 
SAME MOMENT AS GOKU, HE HARBORED A MYSTERIOUS RESENTMENT TOWARD HIM.  BROLY'S 
FATHER TRIED TO USE HIM AS A WEAPON TO RULE THE UNIVERSE, BUT EVENTUALLY 
HIS POWER WAS TOO STRONG, AND HE BROKE THE CONTROL MECHANISM. ONCE FREE, HE 
ATTEMPTED TO KILL GOKU. BROLY IS AN OVERWHELMINGLY POWERFUL FIGHTER--AND IN 
HIS SUPER SAIYAN STATE, HE IS A FORCE TO BE RECKONED WITH! HIS SUPER MOVES 
INCLUDE THE HOVERCRAFT PUNCH AND SEISMIC PUNCH.  

Nappa: NAPPA IS A SAIYAN WARRIOR, AND CAME TO EARTH WITH THE INTENT OF 
CAPTURING THE DRAGON BALLS. NAPPA IS VERY BRAWNY AND MUSCULAR, BUT IS ALSO 
OFTENIMPULSIVE. WITH VEGETA'S DISCIPLINE, HOWEVER, HE HAS LEARNED TO STAY 
RELATIVELY CALM. STILL, NAPPA SOMETIMES HAS TROUBLE WITH THE MENTAL ASPECTS 
OF FIGHTING, BUT HE CAN USUALLY MAKE UP FOR IT IN STRENGTH/ HIS SPECIAL  
ABILITIES INCLUDE HIS SIGNATURE MOUTH BEAM, A ONE-HANDED POWER THROW, AND THE 
EARTH QUAKE SLAM. 

Raditz: RADITZ IS GOKU'S SAIYAN BROTHER FROM THE PLANET VEGETA. RADITZ CAME 
TO EARTH TO FIND OUT WHY IT HAD TAKEN SO LONG FOR GOKU TO DESTROY SUCH A  



HELPLESS PLANET. WHEN HE FOUND OUT THAT GOKU LOVED THE EARTH, HE KIDNAPPED 
GOHAN, AND TRIED TO USE ANY TRICKERY POSSIBLE TO CONVINCE GOKU TO DO THE JOB. 
HE ABUSED GOKU'S TRUSTING NATURE, AND LIED TO HIM TO GET THE UPPER HAND. 
RADITZ IS A SAIYAN WARRIOR, AND IS EXCEPTIONALLY STRONG. HIS MOVES RANGE FROM 
THE FLYING ELBOW DROP TO THE ENERGY BEAM CHOP. 

Bonus Settings > Turn of and on things you bought in buy mode. 
Fast Clock – On/Off 
Invisible – On/Off 
Free Supers – On/Off 
Supers – On/Off 
Explosive Touch – On/Off 
Fast Recovery – On/Off 
Instant Death – On/Off 

Bonus Mode > Bonus modes you buy in buy mode 
Sky Battle 2 – On/Off 
Endurance 2x (Automatically put in 1 player menu) 
 Some kind of Multiplayer mode (Automatically placed in  
Multiplayer menu) 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
J.  Basic Moves: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
Here is a list of the basic moves, combos, and attacks: 

Control            |     Action 
___________________|_______________________ 
A button           |    Light Kick 
B button           |    Light Punch 
Control Pad Left   |   Move Left/Block (Note 1) 
Control Pad Right  |   Move Right/Block (Note 1) 
Control Pad Up     |    Jump 
Control Pad Down   |    Crouch 
L Button           |   Heavy Punch 
R Button           |   Heavy Kick 
START              |   Pause 
SELECT             |   Taunt 
L + R              |   Build Up Ki 
Down, Right+B      |   Ki Blast 
Down + B           |   Low Punch 
Forward + B        |    Chop 
Down + L           |   Uppercut 
Back + R           |  Roundhouse Kick 
Down + A           |  Leg Sweep 
Down + Back        |  Low Block 
Down, Down, Up + B |  Fly Up 
L + Forward        |  Throw (Note 2) 
B Button (in air)  |  Jump Punch 
A Button (in air)  |  Jump Kick 
Back + B           | Unique Melee Attack (Note 2)(Note 3) 
Combo 1            | B, B, A, L (Note 4) 
Combo 2            | A, R, B, L (Note 5) 
Combo 3            | A, R, B, L, B (Note 6) 
Throw              | L + Forward (Note 7) 

Note 1: Depends on which direction you are facing. 
Note 2: Need to be close to opponent. 
Note 3: Varies for each character. 
Note 4: Press fast! 



Note 5: Press REALLY fast!!! 
Note 6: Only works for Raditz. 
Note 7: Works better if you do L + R + Forward 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
K. Character Moves: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
  
 Goku: 
Kamehameha: Down, Forward, Down, Forward + B 
Sadly, this Kamehameha is yellow, going against all concepts 
of DBZ. :'( 

Super Kamehameha: Down, Forward, Down, Forward + L 
This is the right Kamehameha.  Coku turns into Super Saiyan,  
and blasts the enemy with a BLUE Kamehameha. 

Genki Dama: Back, Down, Forward, Up + L 
Also known as the Spirit Bomb, Goku jumps into the black place, 
puts his hands over his head, and charges the Spirit Bomb.  
Then he releases it and throws it at the enemy! 

Vegeta: 
Galick Gun: Down, Forward, Down, Forward + B 
Vegeta jumps halfway to the top of the screen, Shoots a purple 
Ki wave at about a 45-degree angle causing about 1/4 a bar  
of damage.

Big Bang: Down, Forward, Down, Forward + L 
Vegeta turns into a Super Saiyan, (sadly his hair is orange)  
and hurls a ball of glowing Ki towards the enemy causing a  
bit more damage than the Galick Gun! 

Oozaru: Back, Down, Forward, Up + L 
Vegeta makes a fake moon, hurls it into the air, and floats  
up with it.  Then, a GIANT MONKEY FOOT (oh terror) CRUSHES  
THE OPPONENT DOING ABOUT HALF A BAR OF DAMAGE!!!!! 

Gotenks: 
Kamehameha : Down, Forward, Down, Forward + B 
Gotenks fires a blue Kamehameha (not as big as Goku's)  
doing a bit less than 1/4 a bar. 

Super Ghost Kamikaze: Down, Down, Left, Right + L 
Gotenks turns Super Saiyan 3, and spits out 5 hazardous 
ghosts (with the same hair do!) whih home on to the opponent 
exploding on contact with about 1/4 a bar of damage! 

Gekitotsu Ultra Buu Buu Volleyball Attack: Back, Down, Forward + R 
One of Gotenks' radicalest (great I'm talking like him now!)  
moves, he fires a beam, turning the enemy into a ball, 
and starts kicking them around in the black place, then  
punches them downward,doing about 1/2 A BAR OF DAMAGE!!!! 

Gohan: 
Multi-Blast: Down, Back, Forward + B 
Gohan fires seven Ki blasts doing about 1/4 a bar of damage 

Masenko Ha: Back, Down, Forward + L 
Gohan's signiture move, he turns into a Super Saiyan, charges  



up an energy ball in his hands, then lets it rip on the  
opponent doing about 1/2 a bar of damage!!! 

Super Kamehameha: Down, Forward + B, Down, Forward + L 
A move inherited from his dad, Gohan charges up the move and  
drills it into the opponent (litterally) causing about  
2/3 A BAR OF DAMAGE!!!!!!! 

Piccolo: 
Special Beam Cannon: Forward, Back, Down, Forward + B 
Piccolo's trade mark, he puts his finger to his forehead  
and then shoots a drilling beam causing 1/3 a bar of damage! 

Fierce Ranma: B, B, A, A, Forward + R 
Piccolo runs around really fast kicking and punching the  
opponent in lots of different ways  
causing about 1/4 a bar of damage. 

Hell Zone Grenade: Down, Back, Down, Back + L 
Piccolo's level 3, he shoots lots of Ki balls around  
the opponent and orders them to crash on the  
poor victim! 1/3 bar of damage! 

Trunks 
Final Slash: Down, Back, Down, Back + B 
A single slash comes out of his sword hitting the  
opponent with 1/5 bar of damage. 

Triple Slash: Down, Back, Down, Forward + L 
Trunks turns Super Saiyan, then swings the sword  
three times with 1/3 bar of damage! 

Burning Attack: B, R, Back, A, L, Forward 
He turns into Super Saiyan, moves his arms  
around, shoots a big Ki ball, then catches his sword  
on fire and brings down some sword slashing pain with 
about 1/2 A BAR OF DAMAGE!!! 

Cell:
Tail Stab: Back, Down, Back, Forward + B 
Cell stabs the opponent with his tail doing less than  
1/4 a bar of damage! Sadly he stays as imperfect Cell... 

Uppercut to Weak Kamehameha: Down, Forward, Down, Forward + B 
He turns into Perfect Cell, uppercuts the opponent into the air,  
when they come down he shoots a  
yellow Kamehameha at them doing about 1/3 bar of damage! 

Super Kamehameha: Down, Forward, Down, Forward + L 
As usual a Super Kamehameha means a blue one, for me, this is  
the hardestsuper move to pull off, I've  
only done it once or twice. 

Brolly: 
Hovercraft Punch: Back, Down, Forward + B 
Brolly boosts towards the opponent with his fist out causing 
about 1/4 a bar of damage. 

Seismic Punch: Back, Down, Forward, Down, Back + R 



Technically this isn't a punch, Broly turns Super Saiyan,  
fire-works go off doing about 1/4 a bar of damage. 

Legendary Super Saiyan Ki Beam: Down, Back, Down, Forward + L 
This is the move that makes up for the sucky seismic punch.   
He turns Legendary SS, and shoots a GIANT green 
beam doing about 1/2 a bar of damage!!! 

Krillin: 
Super Head-Butt: Down, Forward, Down, Forward + A 
Krillin gets a flame around his head jumps toward the enemy 
and does about *yawn* 1/8 a bar of damage.  
Woooooooooo. 

Kamehameha: Down, Forward, Down, Forward + B 
The usual. Yellow Kamehameha. 1/4 bar of damage. 

Destructo Disk: Back, Down, Forward, Back + L 
Krillin throws a discus of energy at the opponent causing 
almost 1/2  
a bar of damage!! 

Android 18: 
Multi-Ki blast: Down, Back, Down, Forward + B 
18 fires 7 Ki blasts doing almost 1/4 bar of damage. 

Positronic Beam: Back, Forward, Back, Forward + B 
She fires a swirvy beam that does a bit more than 1/4 a bar of  
damage. 

Triple Rocket Attack: Forward, Down, Back, Forward + L 
She shoots rockets form her back doing about 1/2 bar of damage. 

Raditz: 
Flying Elbow Drop: Down, Forward, Down, Forward + B 
Raditz jumps into the air bringing his elbow crashing down on  
the opponent doing 1/4 bar of damage. 

Energy Beam Chop: Back, Forward, Back, Forward + B 
Can you say, "This move declares Raditz is a idiot"? This is  
just basically a extended chop, doing about  
as much as a regular chop (Forward+B). 

Fireball Somersault: Back, Forward, Down, Forward + R 
This is what pays up for Energy Beam Chop!!!  Raditz jumps into  
the air, starts somersaulting towards the 
enemy with fire surrounding him, doing about 2/3 A BAR OF  
DAMAGE! 

Nappa: 
Mouth Beam: Forward, Down, Left, Right + B 
Nappa shoots a beam out of his mouth doing about 1/4 a bar of  
damage. 

One-Handed Power Throw: Back, Forward, Down, Forward + L. 
He throws them at the wall doing about 1/4 a bar of damage.  
(Need to be VERY close) 

Earthquake Slam: Back, Down, Forward, Up, Back + R 



He jumps in the air floats there doing front flips, then kicks  
them towards the ground doing 1/2 a bar of damage! 

Android 16:  
Double Arm Beam: Back, Forward, Back, Forward + B 
Can you say, "1/10 of a bar!!!!!!!!!"?  Thtas how much it does. 

Rocket Punch: Back, Down, Forward + L 
He shoots rockets out of his hands doing about 1/4 a bar of  
damage. 

Self-Destruct: B, B, R, A, L 
The best move in the game, He explodes (need to be VERY close) 
doing them 3/4 a bar of damage and you 
1/4 a bar of damage. 

Buu: 
Hammer Fist: Down, Forward, Down, Forward + B 
Buu molds his fist into a hammer, then pounds on the opponent. 
1/4 bar of damage! 

Henka Beam: Back, Forward, Down, Forward + L 
Buu turns into Super Buu, turns them into candy then eats them, 
1/2 bar of damage. 

Human-Extinction Blast: Back, Down, Forward, Up + L 
Buu turns into Super Buu, then fires a couple beams in the sky 
and they rain down doing about 1/10 bar of damage each. 
  

Frieza: 
Eye Beam: Forward, Back, Down, Forward + B 
Shoots a beam out of his eye doing 1/6 a bar of damage. 

Homing Energy Disk: Forward, Back, Down, Forward + L 
Summons a Ki discus a fires it at the opponent doing about 1/4 
 a bar of damage. 

Death Ball: Forward, Down, Back, Forward + L 
He summons up energy + fire in his hand, the chunks it at the  
opponent doing almost 1/2 a bar of damage! 

Note: (All moves were tested by me and they all work.) 

Note: (All moves were tested on Gohan, all characters have a  
different defense rating 
so the moves might not do as much on Piccolo as, let's say,  
Krillin.) 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
L. Contacts and stuff…………: 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
If you’d like to thank me e-mail me at mynameis_11@hotmail.com 
People who are flooding my inbox with hate mail WILL BE B 
LOCKED!Plus I spent a lot of time on this so don’t e-mail me  
telling me how much it sucks, k? 

This guide is copyrighted (c)December 2003 by g0ldenSun11, and  



is only to be used on www.gameFAQs.com. It may be  
copied and re-posted on another site w/ special permission from  
g0ldenSun11. 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
M. Special Thanks 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

Special thanks to... 

g0ldenSun11: For making this guide. 

ikowarrior255: For helping make this guide. 

CJaYC: For making GameFAQs. 

ikowarrior255: For helping get info for this guide. 

g0ldenSun11: For getting most of the info for this guide. 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
N. Version History 
=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

Main Menu: *complete*-100% 

Unlockable Characters: *complete*-100% 

Tournament: [See Maybes] *complete*-100% 

Time Challenge: [See Maybes] *complete*-100% 

Sparring: *complete*-100% 

Endurance: *complete*-100% 

Multi-player: *complete*-100% 

Options: *complete*-100% 

Z Store: *complete*-100% 

Basic Moves: Unless more combos are discovered: *complete*-100% 

Characters' Specials: *complete*-100% 

Total: *very close!!*-95% 

_______________________________________________________________________________ 

Version .1: Almost everything complete. 

Version .2: Finished the characters' specials; all of them listed. 

Version .3: Added Multi-player menu layout and character bios. Added the throw 
command to Basic Moves. 

=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 
O. Maybes 



=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-= 

Main Menu: *NONE* 

Unlockable Characters: *NONE* 

Tournament: I may put strategies for beating characters (remember, this is a 
maybe; imay or may not put this up). 

Time Challenge: I may put some strategies for beating characters the quickest. 

Sparring: *NONE* 

Endurance: *NONE* 

Multi-player: *NONE* 

Options: *NONE* 

Z Store: *NONE* 

Basic Moves: *NONE* 

Characters' Specials: *NONE*

This document is copyright g0ldenSun11 and hosted by VGM with permission.


